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1 Getting Started 

1.1 What is the Model Test Manager? 
Model Test Manager (or MTM for short) is an add-on software package for MATLAB 
that helps users manage the instrumentation and calibration of models in Simulink and 
Stateflow. Users can instrument the models with a variety of familiar standard  
Simulink sinks such as Scopes, Displays and ToWorkspace blocks, and standard  
Simulink  sources such as Constants, Step signals and Ramp signals etc., through a user-
friendly Graphical User Interface (GUI). Similarly users can calibrate parameters 
associated with most of the built-in  Simulink  blocks such as Constant, Gain, and 
Saturation etc., through the MTM GUI. Once the user assembles the instrumentation and 
calibration lists interactively using MTM GUI, the tool can be used to save the particular 
instrumentation and calibration configuration. This saved configuration can be retrieved 
and loaded into the tool at any time to re-create the instrument and calibration 
configuration on the model. The instrument and calibration information is maintained 
independent of the model and hence the underlying model is uncorrupted. Numerous 
scenario-specific instrumentation and calibrations can be interactively developed and 
applied on the same model. 

1.2 When do you use the Model Test Manager? 
This tool is useful whenever there is a need to model in  Simulink  and  Stateflow. In 
particular,  

• MTM is handy while debugging or testing a large model with several levels of 
model details. MTM provides a means to open any of the instruments in the 
model with a simple right-click of the mouse on the relevant instrumented signal 
name in the GUI. This is considerably easier than traversing different levels in the 
model to open a particular instrument, which is the conventional way.  

• If the Simulink model is to be shared between several people in a project team, it 
is usually difficult to customize the instruments in the model because the needs of 
different team members may vary. Usually, the team ends up instrumenting all the 
signals even though a majority of the signals will not be used by many of the 
model users all the time. This issue can be easily resolved with MTM, where 
every user maintains individual instrumentation configurations and the shared 
model is left uncorrupted. The individual instrumentation information can also be 
shared among project members. 

• The use of custom component libraries in Simulink is growing among modelers. 
The process of debugging and testing of models assembled using library 
components gets extremely difficult because the manipulation of debugging 
instruments within library-linked model elements involves manipulating (adding, 
changing, deleting) instruments inside the source library elements. Also, Scopes 
cannot be used as debugging tools within library-linked elements because 
Simulink does not allow that. However, MTM makes it a breeze to add 
instruments within library-linked elements. There is no difference between 
library-linked and non-linked elements as far as the user is concerned. All the 
processing is handled seamlessly and it is transparent to the user. 
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• MTM is very useful in performing model parameter calibrations and parameter 
sweep studies. 

 
Besides the above listed benefits, users can take advantage of a built-in Search Engine to 
search configuration files and data files for user-added comments and a built-in Data 
Save tool to selectively save and retrieve simulation results. 

1.3 How can you use the Model Test Manager? 
Two modes of usage are possible: 
Interactive Mode: In this mode, the user builds and manages the instrumentation and 
calibration  information on the model through the MTM GUI. The user can instrument 
and calibrate the model by clicking on a button in the GUI after defining all the 
instrument and calibration properties on the signals. The instrumentation and calibration 
setup can be managed and manipulated in this mode. The user can also use all the built-in 
tools such as the Search Engine and the Experiment Data Save. 
Batch Mode: The user can utilize the tool to apply a saved instrumentation and 
calibration configuration on a model using this mode. The instrumentation and calibration 
setup cannot be managed and manipulated in this mode. This mode is particularly useful 
to invoke the instrumentation and calibration capabilities as part of a batch script. As an 
example, the user may have saved ten different configuration files to be used with ten 
consecutive experiments. The model experiments can be scripted and the batch mode 
MTM procedures can be used in this script to add experiment relevant instrumentation 
and calibration on the model.   
 
2 System Requirements 
Model Test Manager, Version 1.0, is currently supported for the following platform and 
configuration: 

• Compute Platform: PC 
• Operating System: Windows 9x, NT, 2000, 2003 
• MATLAB Version: 6.1 (Release 12.1), 6.5 (Release 13) and 6.5.1 (Release 13 

SP1) 
 
Since the MTM tool has been designed using m-scripts, the tool may work for other 
platforms as well. However, at this time, MTM has been tested only in the above 
platform and configurations. Future releases for other platforms are planned. 
 
3 Installation Instructions 

1. Copy the executable, mtm_release_v*.exe (or the corresponding zipped file if you 
had received a *.zip file), to the destination directory where you want to install the 
files.  

2. Run the executable, mtm_release_v*.exe, by double clicking on it. (If you had 
received a zipped file, then double click it to open the zipped folders. This will 
require the user to have access to WinZip or a similar utility. You can extract the 
zipped files to a destination of your choice.) 
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3. The program would prompt you with the destination directory where the files 
would be installed. If you want to change the destination directory, you can do so 
now. 

4. After the files are installed, start  MATLAB and include the folder mtm_release 
and all the folders beneath the folder mtm_release (in your destination directory 
for MTM in the previous step) into your  MATLAB path. The procedure to do 
this: 

a. Open Set Path utility from the  MATLAB File menu (see Figure 1). 
b. Use the “ Add with Subfolders”  button to add the MTM related folders into 

path. When “ Add with Subfolders”  button is pressed it will bring up 
another window titled “ Browse For Folder” . 

c. In the “ Browse For Folder”  window, navigate to the folder where you 
have installed the MTM files. Pick mtm_release and click on “ OK” . This 
will add the folder mtm_release and all the folders below mtm_release to 
the MATLAB path and this can be confirmed by looking into the 
MATLAB search path shown in “ Set Path”  window. 

d. On closing the “ Set Path”  window, click on “ Yes”  to permanently include 
the new file paths in your  MATLAB path (otherwise you have to repeat 
this procedure at the beginning of every  MATLAB session). 

5. Ready to run Model Test Manager – type  
 

>> instrument_model 
 

at the MATLAB  prompt to open the main MTM GUI (see Figure 2). 
6. The on-line help is available by using the pull down under Help in the main MTM 

GUI and picking Help on MTM. 
 

 
Figure 1: Set Path GUI in MATLAB 
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4 Quick Tutorial 
This section describes a beginner’s tutorial so that interested users can quickly start using 
the core functionality of the tool without knowing all the details. Once you have installed 
Model Test Manager and have included all the folders in  MATLAB path, you can run 
this tutorial within  MATLAB. This tutorial shows step-by-step how to instrument a 
model in the Interactive Mode using MTM. 

1. Invoke MTM GUI from the command line using the following command.  
>> instrument_model 

This should open up the main MTM GUI (see Figure 2). You can also invoke the 
main MTM GUI from MATLAB LaunchPad (see Section 5.4). 

2. Open the Simulink model which you want instrumented. 
3. If this is the first time this model is being instrumented, you have to add the 

“ Signal Capture”  block at the root level of this model. This procedure is as 
follows: 

a.  You should see a library called “ Model Instrumentation”  along with the 
standard  Simulink blocks in the Library Browser. If you do not see this 
element, then the MTM folders have not been properly included in the 
MATLAB path. 

b. Expand “ Model Instrumentation”  library by clicking on the “ +”  symbol in 
front of its name.  

 
Figure 2: Main MTM GUI 
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c. Drag and drop “ signal_capture”  element into the root level of the model 
that needs to be instrumented. The resulting block should look like the 
blue “ Signal Capture”  block in the example model (see Figure 3).  

d. If your model contains library-linked elements and if you are interested in 
adding instruments on signals inside those linked elements, then drag and 
drop the “ signal_capture”  block in “ Model Instrumentation”  to the root 
level of those libraries. Also, if you want to add Scopes on a vector signal 
inside library-linked elements, you may have to follow the specific steps 
in defining the instrument properties. For this quick beginner’ s tutorial, 
you may want to avoid adding Scopes inside library-linked elements. 

 
Figure 3: Screen shot of Simulink Library browser with Model Instrumentation library selected 

4. Type in the model name (that you want instrumented) in the Model Name 
window of the MTM GUI and press Enter. This should pull up a view of the 
model in the System Tree window. The entries with a “ +”  symbol in the front 
denote subsystems that have other blocks beneath. You can double click on those 
elements to expand the sub-trees. The System Tree displays elements that have 
outputs, inputs and parameters (and hence can be instrumented or calibrated). 

5. Click on any element in the System Tree and that should display the outputs, 
inputs and parameters of that element in the window below the system tree. If the 
signal wires connected to the output (input) ports carry a name, then that name is 
shown in the Outputs (Inputs) window. If the signal wires are not labeled, then the 
name appears generically as “ output<n>“  (“ input<n>“ ) where “ n”  represents the 
order of the output (input) on the block. 

6. To add a sensor type instrument on one of the signals displayed in the Outputs 
window, right click on the signal in the Outputs window and select “ Add” . This 
should open up the Edit Sensor Properties GUI. 
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7. The instrument “ ToWorkspace”  block is selected by default. To change this, pick 
another selection from the Instrument Type pull down menu. The properties for 
“ Display”  and “ ToWorkspace”  blocks are shown in the Edit Instrument Properties 
GUI. The default values for these properties are shown in the window. Any valid 
entry that can be used with the corresponding Sink element in  Simulink can be 
entered in the appropriate form in the Edit Sensor Properties GUI. To view the 
default and edit the Scope instrument properties click on “ Edit Scope Properties”  
button. This should pull up the standard Scope properties window except that the 
“ floating scope”  option is unavailable. Also the “ Number of axes”  property is 
always set to 1 for Scope. The default “ Signal Name”  is inherited from the 
“ Outputs”  window of the main MTM GUI. This name appears in the Instrument 
List window of the main MTM GUI. Since the names in the Instrument List have 
to be unique, pick a signal name that lets you relate the instrument with a signal in 
your model. If the name entered in the “ Signal Name”  field is already used by 
another element in the Instrument List, then the tool prompts for an alternative 
name when “ Done”  is clicked in the MTM-Edit Sensor Properties GUI. 

8. After configuring the sensor properties, click on “ Done”  button in the Edit Sensor 
Properties GUI to include this new addition in the Sensor List. 

9. Repeat previous process steps 5 through 8 to include additional signals in the 
Sensor List window. 

10. To add actuators and calibrations to corresponding list windows similar procedure 
should be used.  

11. To instrument model with the signals in the Instrument List windows, click on 
“ Instrument Model”  button in the main MTM GUI. 

Check your model to see if the signals that you want instrumented has a connection to a 
block with the tag “ MTM Scope”  or “ MTM Display”  or “ MTM ToWorkspace”  or 
“ MTM Actuator”  displayed on them. An example screen capture in  Simulink is shown 
here. After running a simulation, you may view any of the instrumented signals by right 
clicking on the corresponding names in the Instrument Lists with the mouse and selecting 
“ Open Instrument”  from the context menu. Opening a Scope instrument should display 
the standard Scope view. Opening a Display instrument should show a subsystem with 
the Display element and opening a ToWorkspace instrument should show a standard plot 
window with the instrumented signal(s) plotted. Opening an Actuator instrument will 
show a standard plot with raw signal, actuator source signal and the actuator output signal 
plotted. 
 
5 Before you begin 
Make sure your computer system and the MathWorks tool suite satisfy requirements 
described under System Requirements section. The folder mtm_release is generated after 
installation of MTM software. Include all the folders under the directory mtm_release in 
your  MATLAB path. This procedure is described here. 

5.1 Including the MTM folders in MATLAB path 
After the MTM files are installed, start MATLAB and include the folder mtm_release 
and all the directories beneath the folder mtm_release into your  MATLAB path. The 
procedure to do this: 
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1. Open Set Path utility from the  MATLAB File menu (see Figure 1). 
2. Use the “ Add with Subfolders”  button to add the MTM related folders into path. 

When “ Add with Subfolders”  button is pressed it will bring up another window 
titled “ Browse For Folder” . 

3. In the “ Browse For Folder”  window, navigate to the folder where you have 
installed the MTM files. Pick mtm_release and click on “ OK” . This will add the 
folder mtm_release and all the folders below to the MATLAB path and this can 
be confirmed by looking into the MATLAB search path shown in “ Set Path”  
window. 

4. On closing the “ Set Path”  window, click on “ Yes”  to permanently include the new 
file paths in your  MATLAB path (otherwise you have to repeat this procedure 
at the beginning of every  MATLAB session). 

5.2 Enabling a model for MTM usage 
Models can be instrumented using the MTM GUI as long as they contain the Signal 
Capture block at the root level. If your model includes library-linked elements and if you 
want to instrument signals inside the library-linked elements, then you have to include the 
Signal Capture block in the root level of each of the libraries. Open the Simulink    
Library browser. This can be done by typing “ simulink”  in the command window or 
clicking on  Simulink icon at the top of the command window. If you have , you should 
see an icon for Model Instrumentation in  Simulink Library browser. Expand the view 
of this library by clicking on the “ +”  symbol in front of its name. The expanded view 
shows the element signal_capture. To include the Signal Capture block in the root level 
of your model or library, drag and drop this element to the desired destination location. In 
the case of a library, you may have to unlock the library before adding this Signal 
Capture block. The resulting block should look like the blue “ Signal Capture”  block in 
the example model (see Figure 4). Double click the “ Signal Capture”  block in the model 
and it should display the mask parameter option for this block. 
Caution: There has to be only one Signal Capture block in the target model and in each 
of the associated libraries. Presence of multiple Signal Capture blocks in the target model 
or in any of the libraries may lead to errors. 
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Figure 4: Example Model with MTM instruments & Signal Capture block 

5.3 Signal Capture Block Parameter Options  
Currently, there is one parameter choice for the Signal Capture block. The user can have 
the MTM tool automatically check all the instrumented signals in the model before every 
simulation by selecting the checkbox. By default, this option is not selected. The 
simulation may slow down if there are a large number of instrumented signals and if this 
option is chosen. This is because the tool checks the presence of every instrument in the 
model just before the simulation starts and warns the user if any of the instruments in the 
MTM Instrument List is missing. So, some computation time is spent during simulation 
initialization for this task. 

5.4 Invoking MTM from MATLAB LaunchPad 
MTM tool can be invoked in the interactive mode from MATLAB LaunchPad. This is 
shown in Figure 5. If you do not see “Large Model Management” in the LaunchPad, 
then right-click within the LaunchPad window and select “Refresh”. This should 
make “ Large Model Management”  visible. Click on the “ +”  symbol to explore inside 
“ Large Model Management” . Then, double-click on the MTM icon to invoke the main 
MTM GUI for the interactive mode. MTM can be launched from command window also 
and see Section 6 and Section 10 for more on opening MTM from command line. 
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Figure 5: Invoking MTM from MATLAB LaunchPad 

6 The main Model Test Manager GUI 
The main Model Test Manager GUI is invoked by typing 

>> instrument_model  
at the command prompt. There are several other ways to start the main MTM  GUI(see 
Section 10). The main MTM GUI (see Figure 2) has several fields. 
Model Name: This displays the current active model that is being instrumented with the 
tool. All operations in the GUI correspond to this model. The active (open) models are 
displayed in the context menu when one right-click on this dialog (see Figure 6). On 
picking one of the open models, the tool updates the System Tree. The Browse button 
can be used to browse the file system and open a model stored in an “ .mdl”  file. This 
operation also updates the System Tree with the open model information. 
 

 
Figure 6: Context Menu of Model Name Dialog showing open Simulink Models 
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System Tree: This displays the tree view of the model shown in the Model Name dialog. 
The blocks with at least one output or input are shown in this window. Blocks with no 
outputs and inputs are not shown in this window. Signals that can be instrumented have 
to be associated with an input or output port of a block in  Simulink. Hence, blocks with 
no outputs and inputs are ignored in the System Tree browser of MTM. Subsystems in 
the tree are displayed with a “ +”  symbol. Double clicking on these subsystems expands 
the view to show the blocks beneath the subsystem level. Selecting a name and holding 
the cursor on a name displays the complete model path for that block as a tool tip. 
Inputs/Outputs/ Parameters Selector: Choice of inputs/ outputs/ parameters in the pull 
down menu updates the list box accordingly. 
Inputs/Outputs/Parameters List:  
Displays inputs/ outputs/ parameters of the selected block in system tree based on the 
choice in the pull down menu. 
Example: Let the choice in selector be “ Outputs” . 
The outputs of the block selected in the System Tree are displayed in this dialog. If the 
signals originating on those ports have names (names on the connecting wires), then 
those names are displayed in this window. Otherwise, a generic name “ output<n>“  is 
used where n is the order number of the output signal on the block. Sometimes, signal 
names that are inherited from their respective sources are not displayed. A probable 
reason for this could be that the model has not been updated to display the inherited name 
on the block output signals. Update the model (pick Update Diagram from the Edit menu 
in the  Simulink model window and then update the System Tree by pressing “ Enter”  in 
the Model Name window) to see all the names. You have the option to view port names 
on Subsystems. The default option always shows the signal names. To view port names 
on a particular subsystem, select that subsystem in System Tree and then right-click in 
Outputs dialog and pick “ Show Port Names”  (see Figure 7). Port names can appear as 
default in the Outputs dialog for all Subsystems in the current MTM session by picking 
“ Show Port Names for Subsystem”  under Options pull-down menu. Any “ newline”  or 
“ carriage return”  in the signal names (or port names) are automatically replaced by 
double underscore (“ __” ) symbols in the Outputs dialog. This is done to avoid potential 
problems with instrument names in the tool (see below). 

 
Figure 7: Context Menu of Outputs (Inputs & Parameters) List Box 

Instrument Model: This button is pressed to instrument the target model with the 
“ instruments”  shown in the Sensor/Actuator/Calibration List windows. Those signals that 
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are no longer available in the model (possibly due to model updates) are tagged with the 
“ X”  symbol in front of their names and displayed in the Sensor/Actuator/Calibration List 
windows after the instrumentation process (see Figure 2). 
Acquire Target Block: This button is pressed to bring the current block selected in  
Simulink window into the System Tree of the MTM GUI. This is useful to quickly jump 
to a certain block in the System Tree while browsing the Simulink model. Just select the 
block that is of interest and click on Acquire Target Block to jump to this block in the 
System Tree.  
Group: This indicates the current group. This acts as a groups filter and users can select 
a specific group from the pull down list which shows all the available groups (see Figure 
8 ).  

 
Figure 8: Groups Pull Down List 

Only instruments belonging to the selected group are displayed in the Sensor List, 
Actuator List and Calibration List. By default all instruments are shown. To add 
instruments into specific groups, create new group using context menu (see Figure 9). 
Then select the instruments and use “ Add to groups”  feature. 

 
Figure 9: Context menu of Group Pull down List 

Instrument Filter: This acts as a view filter and users can change the view by using the 
pull down list (see Figure 10). By default, all instrument lists are displayed. By choosing 
different view options, one or two of the instrument lists can be hidden. 

 
Figure 10: Instrument Filter Pull Down List 
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Sensor List: Current list of configured sensors is displayed in this window. The sensor 
instrument can be edited by double-clicking on the name. Right-click with a mouse on a 
sensor name displays other context sensitive menus associated with the Sensor List (see 
Figure 11). Picking a sensor name and holding the cursor on it, displays all the properties 
of the sensor. 

 
Figure 11: Sensor List and its Context Menu 

Actuator List: Current list of configured actuators is displayed in this window. The 
actuator instrument can be edited by double-clicking on the name. Right-click with a 
mouse on an actuator name displays other context sensitive menus associated with the 
Actuator List (see Figure 12). Picking an actuator name and holding the cursor on it, 
displays all the properties of the actuator. 
 

 
Figure 12: Actuator List and its Context Menus 

Calibration List: Current list of configured calibrations is displayed in this window. The 
calibrations can be edited by double-clicking on the name. Right-click with a mouse on a 
calibration name displays other context sensitive menus associated with the Calibration 
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List (see Figure 13). Picking a calibration name and holding the cursor on it, displays all 
the properties of the calibration. 

 
Figure 13: Calibration List and its Context Menus 

6.1 Adding a signal to the Sensor/Actuator/Calibration Lists 
Signals in a model can be instrumented or calibrated by first adding them to the 
Sensor/Actuator/Calibration Lists of the main MTM GUI. To add a signal to the 
Sensor/Actuator/Calibration Lists, first one needs to select a target block corresponding 
to this signal. There are two ways in which a block can be selected 
 
Using the model browser:  

1. The desired model name should appear in the Model Name window of the main 
MTM GUI.  

2. If the System Tree is not current, update the System Tree by placing the cursor in 
the Model Name window and pressing enter.  

3. Browse down to the block level in the System Tree where the signal needs to be 
instrumented or calibrated. Select the target block. Inputs or outputs or parameters 
of the target block are displayed in the input/output/parameters window of the 
main MTM GUI.  

 
Using Acquire Target Block button 

1. The desired model name should appear in the Model Name window of the main 
MTM GUI.  

2. If the System Tree is not current, update the System Tree by placing the cursor in 
the Model Name window and pressing enter.  

3. Browse down to the block level in the  Simulink model window and select the 
target block with the mouse. This makes the target block the current selected 
block in  Simulink. 

4. Click on Acquire Target Block button in the main MTM GUI. This displays the 
expanded view of model in the System Tree and selects the target block 
automatically. 

 
After selecting the target block: 
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1. Right click on the desired input/output/parameter in the Inputs/Outputs/Parameter 

list and select Add (see Figure 7). This brings the corresponding Edit Properties 
GUI (see Figure 16, Figure 17, & Figure 18).  

2. The name shown in the inputs/outputs list is automatically inherited as Signal 
Name. However, note that if there are any empty spaces in the name, then these 
are automatically replaced by underscore (“ _” ) symbols in the Edit Instrument 
Properties GUI. 

3. Change the properties of the instrument or calibration as desired and click on 
“ Done” . This should display the desired instrument name in the Instrument List 
window. It will be noted that the name that appears in the 
Sensor/Actuator/Calibration List has upper case for its first character. The tool 
does this automatically. 

6.2 Delete signals from the Sensor/Actuator/Calibration Lists 
Three different options are available for removing signals from the 
Sensor/Actuator/Calibration Lists. These options can be accessed by right clicking on the 
target name in the Sensor/Actuator/Calibration List and picking one of the choices for 
“ Delete”  context menu (see Figure 11, Figure 12, & Figure 13). 
 
Delete selected instrument: Selecting this option deletes the selected instrument or 
calibrations from the corresponding list. This operation is irreversible. Multiple selections 
can be made in the Instrument List dialog and this activates a single entry in the context 
menu to “ Delete Selected”  signals. This deletes the selected signals from the 
Sensor/Actuator/Calibration List. 
Delete all instruments: Selecting this option deletes all the names from the 
corresponding List. This operation is irreversible.  
Delete unavailable instruments: This option is useful when the model has changed 
since the Sensor/Actuator/Calibration List was created and some of the old instruments or 
calibrations (on signals that are no longer available in the current model) are not needed. 
This operation is irreversible. 
 
Important: While deleting calibrations from Calibration List, users will be prompted to 
select either current value or startup value and the calibration parameter value in the 
model will be restored to the selected value on deletion of the calibration.   
 
Caution: Deleting the names from the Sensor/Actuator/Calibration List does not 
automatically remove the corresponding instruments or calibrations in the model if the 
model is already instrumented. See Remove instruments and calibrations from the model 
for this operation. 

6.3 Add instruments and calibrations to a model 
After the list of instruments and calibration is assembled in the main MTM GUI (in the 
Sensor/Actuator/Calibration List window), the model is ready to be instrumented. Make 
sure that the model is enabled for MTM Instrumentation. Click on the Instrument Model 
button in the main MTM GUI to add instruments and calibrations to the model. During 
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this process, all the existing instruments and calibrations are deleted in the model and its 
associated libraries and then the new instruments and calibrations are inserted. If some of 
the desired signals are unavailable (due to a change), then the tool displays a message and 
indicates those instruments with the “ X”  symbol in front of the corresponding names in 
the Sensor/Actuator/Calibration List windows (see Figure 2). Also, instruments & 
calibrations which are not enabled or not activated will be indicated with “ x”  in front of 
their names in the Sensor/Actuator/Calibration List windows (see Figure 2). 
 
Options:  
Instrument & Run: There is an option to instrument & run the model in the Options 
menu of the main MTM GUI (see Figure 14) and whenever this option is checked on text 
on the instrument model button in the main MTM GUI will change to Instrument & Run. 
Under this condition if the Instrument & Run button is pressed then the instruments & 
calibrations will be added to the model and then simulation of the model also will be 
started automatically.  

 
Figure 14: MTM Options Menu 

Instrument Current Group only: By default instrumentation process adds all the 
instruments & calibrations to the model (i.e. Instruments & Calibrations belonging to All 
Group). In order to instrument a specific group of instruments & calibrations, users 
required to check the “ Instrument Current Group only”  option in the Options menu of the 
main MTM GUI (see Figure 14) and then switch to that group before pressing the 
Instrument Model button in the main MTM GUI (see 6.10 for more on Groups feature).  

6.4 Remove instruments and calibrations from the model 
All existing instruments and calibrations are automatically removed when a model is 
instrumented. The tool searches through the target model and all of its associated libraries 
and removes all existing (old) instruments and calibrations. If you desire to remove all 
the instruments and calibrations in a model (for any reason) outside the instrumentation 
process, then use the Remove Instruments from Model under the Tools menu in the main 
MTM GUI (see Figure 15). This removes all the MTM instruments and calibrations from 
the active model whose name appears in the Model Name window. This does not 
however delete the names in the Sensor/Actuator/Calibration List windows. See Delete 
signals from the Sensor/Actuator/Calibration List for this operation. 

 
Figure 15: Tools Menu 
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6.5 Properties of Sensor, Actuator & Calibration 
A sensor can be – ToWorkspace, Scope, Display or Custom-sensor. ToWorkspace, Scope 
and Display are standard  Simulink sinks and have all the usual properties afforded in  
Simulink.   
An actuator can inject “ source”  signals of different types and hence the source type 
characterizes the actuator. So actuator can be – any of the standard Simulink sources or 
custom actuator. 
Calibration involves change of parameter and most of the parameters associated with 
standard Simulink blocks are supported in MTM.  
 
Both the instruments and calibrations have some common properties and they are: 

1. Name of the instrument or calibration (denoted as Sensor/Actuator/Calibration 
Name in the MTM Edit Properties GUI) has to be unique in the current 
Instrument Lists. 

2. The block name and the port number, associated with the instrument or 
calibration, are not to be edited in the Edit Properties. These have to be selected in 
the main MTM GUI. 

3. Groups list which displays the groups to which current instrument or calibration 
belongs is not to be edited in the MTM Edit Properties GUI. This groups property 
has to be set in the main MTM GUI. 

4. Users can store comments corresponding to the individual instrument or 
calibration and these comments should be entered in the Comments section of the 
MTM edit Properties GUI. 

6.5.1 Properties of Sensors 
As mentioned above sensor can be – To WorkSpace, Scope, Display or Custom-sensor. 
All the sensors except the custom-sensor have all the usual properties afforded in 
Simulink and these properties can be accessed and edited by clicking on the Edit Sensor 
Properties button in the MTM – Edit Sensor Properties GUI. The various fields in the 
MTM - Edit Sensor Properties GUI (see Figure 16) are as follows: 
 

1. Block Path: Path of the parent block in the Simulink model to which the current 
sensor will be added. This field is not editable. 

2. Port Number: Outport number of the parent block to which the sensor will be 
added. This field is not editable. 

3. Sensor Name: Name of the sensor which will appear in the Sensor List. This 
name should be unique and it is better to have the names without any special 
characters. 

4. Sensor Type: Type of the sensor and sensor can be To Workspace, Scope, Display 
or Custom Sensor. 

5. Edit Sensor Properties: This button can be used to set the properties 
corresponding to selected sensor type. 

6. Static Transfer Function: The static transfer function option is used to generate a 
scaled version of a signal for the Sensor. Any valid statement that can be entered 
in the Function block in  Simulink can be entered here. The signal that is 
displayed in the instrument will have to be a scalar if a unity function (“ 1”  or “ u”  
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in the Static Transfer Function field) is not used. If all of the elements in a vector 
signal in  Simulink have to be displayed in the same instrument, then a unity 
transfer function has to be used. You can use valid function expression on a 
vector signal to display the result in the instrument. As an example, you can use 
“ u[3]*(1+u[2]*u[3])”  on a three-vector signal to pipe the resulting scalar output to 
an instrument. This static transfer function is disabled for Custom Sensors. 

 
Figure 16: MTM - Edit Sensor Properties GUI 

7. Scope Input Width: Width of the signal to which the Scope block is added and 
this field is enabled only when the sensor type is Scope. More information on this 
is provided below. 

8. Group: Displays all the groups to which this Sensor belongs. Default is “ ALL” . 
9. Activate: Whenever the check box corresponding to this field is checked the 

current sensor will be added to the model during the instrumentation process. 
10. Enable: Whenever the check box corresponding to this field is checked the current 

sensor will be enabled for data acquisition in the model.  
11. Comments: Users can enter specific comments in this field corresponding to the 

current sensor and these comments will get stored along with the configuration. 
 
Very Important: Scope blocks cannot be placed inside library elements in the standard  
Simulink package. Using MTM, you can place Scope blocks inside library-linked 
elements of a model. In order to utilize this new functionality, you have to enter the 
Scope Input Width for library-linked elements. This field is ignored for Scope 
instruments that are placed in non-linked model elements. Here, Scope Input Width refers 
to the number of scalar signals that are on the signal line that is being instrumented. Also, 
the Scopes on library-linked elements display the signal as piece-wise constant values. 
The values between the sample points are held constant on these Scope displays. 
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Custom Sensors: Users can implement and include special custom sensor blocks as part 
of MTM sensors. For deploying a custom sensor in MTM, the procedure is as follows: 
 

1. Create a library named “ users_custom_sensor_lib”  in Matlab path to consist of 
custom sensors. It is suggested to keep this library in the “ user_data”  folder in 
MTM. 

2. Create custom sensors in this library using Simulink blocks and custom sensor is 
a subsystem with one input and no outputs. Also, there is a template block titled 
“ customSIMstop”  in “ tmpl_user_custom_sensor_lib.mdl”  file in the “ user_data”  
folder in MTM which can be used as a reference for creating custom sensor 
blocks. 

3. If the custom sensor has parameters which can be changed, then the custom 
sensor has to be masked with those parameters as mask-parameters. Also, in this 
case, “ MaskSelfModifiable”  property should be enabled, since link is maintained 
during instrumentation. Users can use the Edit Sensor properties button to modify 
the mask parameters of the masked custom sensors from the MTM. 

4. If user needs “ Open”  functionality for the custom sensor, then the user has to set 
the “ OpenFcn”  callback for a block inside the custom sensor subsystem (Please 
refer to Simulink Reference for setting “ OpenFcn”  callback). Further, the user 
needs to add an additional parameter (“ OpenFcnBlock” ) to the custom sensor 
mask for entering relative block path of the block which has “ OpenFcn”  callback. 

 
Custom sensors available in the “ users_custom_sensor_lib”  can be accessed from the 
“ Sensor Type”  pull down menu in the MTM – Edit Sensor Properties GUI 

6.5.2 Properties of Actuators 
As mentioned above actuator can be – any of the standard Simulink sources or custom 
actuator. Properties of the standard Simulink sources used in the actuators can be 
accessed and edited by clicking on the Edit Source Properties button in the MTM – Edit 
Actuator Properties GUI.  The various fields in the MTM - Edit Actuator Properties GUI 
(see Figure 17) are as follows: 
 

1. Block Path: Path of the parent block in the Simulink model to which the current 
actuator will be added. This field is not editable. 

2. Port Number: Inport number of the parent block to which the actuator will be 
added. This field is not editable. 

3. Actuator Name: Name of the actuator which will appear in the Actuator List. This 
name should be unique and it is better to have the names without any special 
characters. 

4. Actuator Type: Type of the source associated with the actuator and sources can be 
any of the standard Simulink Sources or User sources. 

5. Edit Source Properties: This button can be used to set the properties 
corresponding to selected source type. 

6. Math Function: The output of the actuator is a function of the actuator source 
signal [u(1)] and the original signal [u(2)] to which the actuator is connected. This 
function can be any valid function which can be entered in the standard  
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Simulink  function block. The chosen function should be entered in this Math 
Function. Following are some valid example functions. 

a. For unmodified signal (no injection of signals) – u(2) 
b. For a new signal where the original signal is ignored – u(1) 
c. For a signal which will add the source to original signal – u(1) + u(2) 

7. Sample Time: Sample Time refers to the sample time of the To Workspace block 
which is used for showing and data logging of the signals associated with the 
Actuator block. The default value of the sample time is –1 (inherited from the 
model) and users can change this if they want to reduce the data logging 

8. Group: Displays all the groups to which this Actuator belongs. Default is “ ALL” . 
9. Activate: Whenever the check box corresponding to this field is checked the 

current actuator will be added to the model during the instrumentation process. 
10. Enable: Whenever the check box corresponding to this field is checked the current 

actuator will be enabled in the model.  

 
Figure 17: MTM - Edit Actuator Properties GUI 

11. Comments: Users can enter specific comments in this field corresponding to the 
current actuator and these comments will get stored along with the configuration 

 
Custom Actuator (User Source): Users can include specialized sources such as time 
based table look-ups to MTM using the User Source.  For deploying a custom actuator in 
MTM, the procedure is as follows: 

1. Create a library named “ users_custom_actuator_lib”  in Matlab path to consist of 
custom actuators. It is suggested to keep this library in the “ user_data”  folder in 
MTM.  

2. Create custom actuators in this library using Simulink blocks and custom 
actuator is a subsystem with no inputs and one output. There is a template block 
titled “ CutomLookUpSource”  in “ tmpl_users_custom_actuator_lib.mdl”  file in 
the “ user_data”  folder in MTM which can be used as a reference for creating 
custom source blocks. 
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Custom actuators available in “ users_custom_actuator_lib”  can be accessed from the 
“ Source Type”  pull down menu in the MTM – Edit Actuator Properties GUI. 

6.5.3 Properties of Calibrations 
As mentioned above Calibration involves change of parameter and most of the 
parameters associated with standard Simulink blocks are supported in MTM. Using the 
MTM – Edit Calibration Properties GUI users can store new value for parameters and 
this new value will be applied to the model when “ Instrument model”  button in the main 
MTM GUI is pressed. Various fields in the MTM – Edit Calibration Properties GUI (see 
Figure 18) are as follows: 

1. Block Path: Path of the block in the Simulink model to which the current 
calibration will be applied. This field is not editable. 

2. Parameter: Simulink dialog parameter prompt corresponding to the current 
calibration. There are some exceptions and in these exceptional cases parameter 
shows the equivalent prompt names. This field is not editable. 

3. Calibration Name: Name of the calibration and this name should be unique as 
mentioned above. 

4. Block Type: Type of the Simulink block to which this calibration will be 
applied. 

5. Start-up value: Parameter value at the time of addition of calibration for the first 
time. Model will always retains this value between different sessions. Users 
cannot edit this field. 

6. Current Value: The present value of calibration parameter in the model. This field 
is not editable and will get updated during the instrumentation process. 

7. Previous Value: The previous value of the calibration parameter in the model. 
This field is not editable and will get updated during the instrumentation process. 

8. Snapshot Value: During the calibration process users can take a snapshot of the 
current calibrations and Snapshot value is the parameter value in the model at the 
time of taking snapshot. This field is not editable and will get updated when ever 
the snapshot is taken.  



Model Test Manager User’ s Guide 
Copyright © 2000 – 2004 Emmeskay, Inc. 

Page 24 of 45 

 
Figure 18: MTM - Edit Calibration Properties GUI 

9. Activate: Whenever the check box corresponding to this field is checked the 
current calibration will be added to the model during the instrumentation process. 

10. Enable: Whenever the check box corresponding to this field is checked the current 
calibration will be enabled in the model. For calibrations this field is always 
checked and cannot be changed by the users. 

11. New Value: This is the new value for the calibration parameter and gets applied to 
the model during the instrumentation process. 

12. Comments: Users can enter specific comments in this field corresponding to the 
current actuator and these comments will get stored along with the configuration 

6.6 Viewing properties of an instrument or a calibration 
The properties of an instrument can be viewed by selecting the corresponding name in the 
Sensor/Actuator/Calibration List window and placing the mouse pointer on the selected 
name. The properties appear as tool tip in the window. Sometimes the properties may not 
appear immediately. Move the mouse pointer outside the Sensor/Actuator/Calibration 
List window and bring it back in to activate the tool tip property in that window.  

6.7 Modifying properties of an instrument or a calibration 
The properties of an instrument or a calibration in the Sensor/Actuator/Calibration List 
can be modified by double clicking on the corresponding name in the 
Sensor/Actuator/Calibration List. This brings up the Edit Properties GUI (that was used 
to add entries to the Sensor/Actuator/Calibration List) with all the current properties filled 
in. Make the required changes to the properties and click on “ OK”  to update the 
Sensor/Actuator/Calibration  List. The model has to be re-instrumented to reflect these 
changes in the model. 
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6.8 Activating / deactivating an instrument or a calibration 
If an instrument or a calibration is de-activated, the instrument is not considered for 
instrumentation and hence does not get added to the model. If some of the instruments or 
calibrations are deactivated MTM indicates these instruments or calibrations with the “ x”  
symbol in front of the corresponding names in the Sensor/Actuator/Calibration List 
windows (see Figure 2). 

6.9 Enabling / disabling an instrument 
This feature is applicable for sensors and actuators. If a sensor/actuator is disabled, data-
acquisition of the instrument does not take place during simulation. 
This feature is accelerated mode friendly. Addition or removal of instruments to the 
model causes re-compilation whereas enabling/disabling the instruments does not cause 
re-compilation in accelerated mode. 
If some of the instruments are disabled MTM indicates these instruments or calibrations 
with the “ x”  symbol in front of the corresponding names in the Sensor/Actuator List 
windows (see Figure 2). 

6.10 Groups 
Groups feature gives you the ability to collect various instruments (sensors, actuators as 
well as parameters) in various groups and then manage these groups. 

1. Creation of new group: Use “ Add New Group”  option in the context menu of 
“ Group”  pull down menu (see Figure 9).  

2. Renaming a group: Select the group that you want to rename and then use the 
context menu option (“ Rename Current Group” ) to rename the group (see Figure 
9). Instrument properties get updated accordingly. “ Rename Current Group”  
option in the context menu is disabled when the current group is “ All”  as “ All”  
group is the default group . 

3. Removal of a group: Select the group that you want to remove and then use the 
context menu option (“ Remove Current Group” ) to remove the group (see Figure 
9). On removing the group, the current group becomes “ All” . The instrument 
properties get updated accordingly. Note that removal of group removes only the 
group and not the instruments that were in the group. “ Remove Current Group”  
option in the context menu is disabled when the current group is “ All”  as “ All”  
group which consists of all instruments and calibrations cannot be removed 

4. Adding instruments to groups: Instruments can be added to groups by the 
selecting the required instruments and using the “ Add To Groups”  option of the 
context menu (see Figure 13 for example). A list dialog displays the available 
groups. By choosing the groups, the selected instruments become members of the 
selected groups. 

5. Removing instruments from groups: Instruments can be removed from groups 
by selecting the required instruments and using the “ Remove From Groups”  
option of the context menu (see Figure 13 for example). A list dialog displays the 
available groups. By choosing the groups, the selected groups are removed from 
the chosen instruments. 
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6.11 Sorting the names in the Sensor/Actuator/Calibration List 
The names in the Sensor/Actuator/Calibration List can be sorted in two ways. 

1. Alphabetical order: By right clicking anywhere within 
Sensor/Actuator/Calibration List and picking Sort > by Name option.  

2. Instrument type: By right clicking anywhere within 
Sensor/Actuator/Calibration List and picking Sort > by Type option.  

6.12 Opening an instrument to view simulation results 

6.12.1 Selecting a single instrument and right-clicking on the selection 

Opening MTM Display or MTM Scope  
MTM Display or MTM Scope can be opened to view simulation results after the model 
has been instrumented. This can be done in one of two ways. 
 

1. From the Sensor List in the main MTM GUI: Right-click on the 
corresponding Sensor name in the list and select Open Sensor (see Figure 19). 
If the Sensor List has been changed in any way by adding, deleting or 
modifying, then the tool asks you to re-instrument the model before opening 
the sensor/actuator. This is because each of the change operation can 
potentially result in a non-synchronized setup between the GUI and the model. 

 
2. From the model: Browse down to the target model level in  Simulink until 

you see the relevant instrument (MTM Display, MTM Scope or MTM 
ToWorkspace) in the  Simulink window. Double-click on the MTM 
instruments to view the results. Opening a MTM Display block shows a 
subsystem with the target Display block and opening a MTM Scope brings up 
the standard  Simulink Scope view for that instrument. Changing the 
properties of Scope from the Scope view will not automatically update its 
properties. You have to use the main MTM GUI to change a MTM Scope 
instrument property. 

 

 
Figure 19: Context Menu of Sensor List with Open Sensor option 
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Opening MTM ToWorkspace or MTM Actuator 
1. From the Instrument List in the main MTM GUI: Right-click on the 

corresponding MTM ToWorkspace or Actuator instrument name in the list 
and select Plot (see Figure 11). A context menu, which is activated for MTM 
ToWorkspace only, will be displayed. This context menu has three options: 

a. New Figure: This will open the selected MTM ToWorkspace or 
Actuator instrument in a new standard figure. This figure will have a 
legend with corresponding signal name. 

b. Hold Current Figure: This option can be used only when an MTM 
plot figure is made current by selecting it. Selecting this option will 
result in plotting of the selected MTM ToWorkspace or Actuator 
instrument on the current figure (on top of the existing plot in the 
figure). The procedure is as follows: 

i. Select the MTM plot figure where you want the plot to appear 
ii. Right-click and choose Plot > Hold Current Figure. 

iii. If the selected figure has more than one axes, the user is 
prompted to choose the axes. 

c. Replace Current Figure: This option will result in plotting of the 
selected MTM ToWorkspace or Actuator instrument on the selected 
MTM plot figure. The new plot will replace the previous plot on the 
current figure. 

 
2. From the model: Browse down to the target model level in  Simulink until 

you see the relevant instrument (MTM ToWorkspace or MTM Actuator) in 
the  Simulink window. Double-click on the MTM instruments to view the 
results. Opening MTM ToWorkspace or Actuator instrument will result in 
plotting the corresponding signal in a standard figure.  

6.12.2 Selecting multiple instruments and right clicking on the selection 
 
Plot Together:  Selecting this option will result in a context menu which has following 
three options: 
 

1. New Figure: This will plot all the selected MTM ToWorkspace instruments in a 
new standard figure. This figure will have a legend with all corresponding signal 
names.  

2. Hold Current Figure: Selecting this option will result in plotting of all the 
selected MTM ToWorkspace or Actuator instruments on the selected MTM plot 
figure. The procedure is as follows: 
a. Select the figure window where you want the plot to appear 
b. Right-click and choose Plot Together > Hold Current Figure. 
If the selected figure has more than one axes, the user is prompted to choose the 
axes. If current figure is not available, a warning is displayed. 

3. Replace Current Figure: Selecting this option will result in plotting of all the 
selected MTM ToWorkspace or Actuator instruments on the selected MTM plot 
figure. The new plot will replace the previous plot on the current figure.  
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If current figure is not available, a warning is displayed. 
 
Subplot: Selecting this option will result in a context menu which has the following four 
options: 
 

1. New Figure: This will subplot all the selected MTM ToWorkspace or Actuator 
instruments in a new standard figure. Each subplot will have a legend with the 
corresponding signal name. The user is prompted for number of axes needed in 
the figure. Then the user is prompted for the axes for plotting each instrument. 

2. Hold Current Figure: Selecting this option will result in plotting of all the 
selected MTM ToWorkspace or Actuator instruments on the selected MTM plot 
figure. If the current figure is a sub-plotted figure, the user is prompted for the 
axes for plotting each instrument. 

3. Replace Current Figure: Selecting this option will result in plotting of all the 
selected MTM ToWorkspace or Actuator instruments on the current figure. The 
previous plot on the current figure will be replaced by the new subplot.  

6.13 Plot slider 
The MTM plot figures provide slider feature in its context menu and this slider bar can be 
used to view the signal values corresponding to a particular instance (time). Slider bar 
can be activated or deactivated by pressing the “ Toggle slider bas”  option in the MTM 
figure context menu(see Figure 20). Use “ Refresh”  feature to update the slider when you 
zoom in/out.  
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Figure 20: MTM Figure with Context Menu showing slider bar options 

6.14 Saving and Loading plot settings (Save Plot-Set, Load Plot-Set) 
MTM provides a convenient feature to save the plotted figure settings like names of the 
plotted variables, line styles, line colors, marker types etc., and MTM also allows 
automatic plotting based on the saved plot settings. For example, consider a case where 
user creates some MTM plots after running a simulation and saves these plot settings 
using MTM. After this he makes some changes in the model and simulates the model 
again. Now he can use load plot settings option from MTM to replot all the figures with 
the current simulation results. These options (save plot settings & load plot settings) can 
be accessed from the tools menu in the main MTM GUI (see Figure 15).   

6.15 Applying New Values of Calibrations 
There are two ways by which users can apply the new values to the calibration 
parameters in the model. 

1. By Pressing Instrument Model Button: After setting the new values for 
calibrations (using the MTM - Edit Calibration Properties GUI) users can press 
“ Instrument Model Button”  to apply these new values in the model.  

2. By using the context menu of Calibration List: For this users need to select the 
calibrations of interest in the Calibration List. After selecting the calibrations they 
can apply the new values by right clicking and then pressing “ Apply New Value”  
option (see Figure 13). Note that the “ Apply New Value”  option will be enabled 
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after the “ Instrument Model”  button is pressed and also it will be disabled 
whenever you add/delete calibrations to/from Calibration List. This method of 
applying new values is useful when user interested in calibration alone and only 
in the first time he needs to use the “ Instrument Model” . From the second time 
onwards users can change the new values from the Edit Calibration Properties 
GUI and can apply these new values by using the context menu of the Calibration 
List.      

6.16 Taking and Applying Snapshots of Calibrations  
During calibration process users may encounter situations in which the current set of 
parameter values gives good results but the users may want to continue calibration in the 
hope to get a new set of parameter values which can give them much better results. In 
these cases users can take a snapshot which will store the current parameter values in the 
model and continue the calibration process. If the further calibration does not yield good 
calibrations then users can apply the snapshot which will apply the snapshot values to the 
model.  Users can “ Take Snapshot”  or “ Apply Snapshot”  by right clocking in the 
Calibration List and clicking on “ Take Snapshot”  or “ Apply Snapshot”  (see Figure 13). 
Please note that the “ Take Snapshot”  and “ Apply Snapshot”  options in the Calibration 
List context menu are enabled after the Instrument Model button is pressed.  

6.17 Calibrating model parameters while Simulation is running 
Some times users may want to calibrate parameters such as controller gains while the 
simulation is running. This can be done by using the Online Calibration Module. This 
online calibration module can be launched by right clicking in the calibration list and 
pressing on the “ Launch Online Calibration”  (see Figure 13). Note that the “ Launch 
Online Calibration”  option in the context menu is enabled only when the model is 
simulating. When the online calibration module is launched, addition or deletion of 
calibrations is not allowed and also the context menu of the Calibration List in the main 
MTM GUI is disabled. The various fields in the online calibration module GUI are as 
follows. 

1. Groups Filter: This indicates the current group. This acts as a groups filter and 
users can select a specific group from the pull down list which shows all the 
available groups. 

2. Calibration Mode: There are two modes of calibrations and these modes are 
applicable to the online calibration only. These modes are 

a. Model mode - In this mode, the parameter value in the “ New Value”  field 
will be applied to the model whenever the “ Apply”  button is pressed. 

b. GUI mode - In this mode, the parameter value in the “ New Value”  field 
will be stored in the memory whenever the “ Apply”  button is pressed.  

3. Group Members: Shows the list of calibrations which belong to the current group. 
4. Startup Value: Parameter value at the time of addition of calibration for the first 

time. Model will always retains this value between different sessions. Users 
cannot edit this field. 

5. Snapshot Value: During the calibration process users can take a snapshot of the 
current calibrations and Snapshot value is the parameter value in the model at the 
time of taking snapshot. 
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6. Current Value: The present value of calibration parameter in the model.  
7. Previous Value: The previous value of the calibration parameter in the model. 
8. New Value: This is the new value for the calibration parameter and gets applied to 

the model during the instrumentation process. 
9. Apply: Button to apply the new value, corresponding to the selected calibration, 

to the model in the Model mode. In GUI mode pressing this button stores the new 
value in the memory and these stored values can be applied to the model by 
switching to the Model Mode after pressing the apply button.  

 
Figure 21: MTM - Online Calibration GUI 

6.18 Identifying the parent block of a MTM instrument signal 
The parent block of a MTM instrument can be viewed by right clicking on the 
corresponding name in the Instrument List and selecting Show Parent Block (see Figure 
11, Figure 12 & Figure 13). This will open the relevant  Simulink model window and 
the target parent block starts flashing. execution is paused during the flashing of the 
block. Click on the (target) flashing block to resume execution. If the model page is busy 
and big, you may have to navigate around the page to find the flashing block. This is 
especially true if the target block resides inside a library-linked element. 

6.19 Capturing the User Preference for open instruments 
You may have a preference on the scopes and displays that have to remain open during a 
simulation run. The position of open MTM Scopes and Displays can be captured and 
saved with the instrumentation setup data. After the model is instrumented, run the 
simulation and open the desired MTM instruments. Place these instruments in the desired 
location and modify (if necessary) the axis properties for scopes to see the signals within 
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the scope window. Now, right-click inside the Sensor List window in the main MTM 
GUI and select Update Sensor Preferences to capture the instrument viewing preferences 
(see Figure 11). If this instrument set is saved and re-loaded, the instrument viewing 
preferences are all retained. 

6.20 Save format for instrumentation setup information 
The Instrument List information (like target blocks, ports and instrument properties) 
along with the current model name is saved as a binary file with “ .mns”  suffix. 

6.21 Saving instrumentation setup information 
The instrumentation information in the Instrument List window along with the current 
Model Name can be saved by using the pull down menu under File and selecting Save 
Instrumentation. This will prompt you for a new file name if you did not open an existing 
instrumentation file. Otherwise, the instrumentation data is saved in the current open file. 
The user has also the option to enter multiple lines of comments. These comments can be 
used as part of a keyword during file search later. The name of the current (open) 
instrument file is displayed in the title bar of the main MTM GUI. In the example figure 
(see Figure 4), the open instrumentation file is base_idle.mns. 

6.22 Saving instrumentation information as a new file 
The instrumentation information in the Instrument List window along with the current 
Model Name can be saved in a new file by using the pull down menu under File and 
selecting Save As option (see Figure 22). This will prompt you for a new file name using 
a standard file browser. The user has also the option to enter multiple lines of comments. 
These comments can be used as part of a keyword file search later. Once the information 
is saved as a new file, the title bar on the main MTM GUI will display the new saved file 
name. The user also has the option of choosing the mns-file version. 

 
Figure 22: MTM GUI File Menu 

6.23 Attaching user comments to the saved information 
While saving instrumentation information or while saving experiment output data using 
the Save Data tool, you have the option of entering some comments. These comments can 
be used to search for the saved file at a later date. See Search engine for files (Section 7) 
for additional information on search capabilities. 
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6.24 Opening a saved instrumentation setup file 
An existing instrumentation information file can be opened by using the pull down menu 
under File in the main MTM GUI and selecting Open Instrumentation (see Figure 22). 
The user is presented with a file browser filtered with *.mns extension and the desired 
file can be located and loaded from here. If you do not remember the name of the saved 
file but remember some keywords in the comments that you entered with the file, then 
you can use the File Search GUI (see Figure 23) to locate and load the instrumentation 
setup file. 

6.25 Printing instrumentation information 
The instrumentation information can be exported in a structured format to a text file for 
documentation purposes. To print the information, use the pull down menu under File 
and select Print Instrumentation (see Figure 22). You will be asked to give a file name for 
this text file. This should result in a document that resembles the sample text below. The 
properties of each of the instruments are documented in the text file. 
 
Model Name:  idle_speed_cntrl 
 
   Sensors: 
 
  1. Sensor name:  Engine_speed  
   Block path:  idle_speed_cntrl/engine 
   Groups:  All, engine_speed, controller 
   Activate:  1 
   Enable:  1 
   User comments:  
   Outport No.:  1 
   Static transfer function:  1 
   Sample time:  0 
   Decimation:  1 
   Save format:  Array 
   Max data points:  1000 
 
  2. Sensor name:  Output1  
   Block path:  idle_speed_cntrl/engine/air_bypass_valve/simple/Gain 
   Groups:  All 
   Activate:  1 
   Enable:  1 
   User comments:  
   Outport No.:  1 
   Static transfer function:  1 
   Sample input:  Decimation 
   Decimation:  1 
   Scope input width:  1 
   Location:  0  0  0  0 
   Open:  off 
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   Number of axes:  1 
   Tick labels:  bottom axis only 
   Time range:  auto 
   YMin:  -5 
   YMax:  5 
   Save to base-workspace:  off 
   Save name:  ScopeData 
   Data format:  Structure with time 
   Limit data points:  on 
 
  3. Sensor name:  Engine_brake_torque  
   Block path:  idle_speed_cntrl/engine/engine_brake_torque 
   Groups:  All 
   Activate:  1 
   Enable:  1 
   User comments:  
   Outport No.:  1 
   Static transfer function:  1 
   Decimation:  10 
   Sample time:  -1 
   Format:  short 
   Open:  off 
   Location:  0  0  0  0 
 
  4. Sensor name:  Speed_error  
   Block path:  idle_speed_cntrl/Controller/Sum3 
   Groups:  All 
   Activate:  1 
   Enable:  1 
   User comments:  
   Outport No.:  1 
   Static transfer function:  1 
   Sample time:  -1 
   Decimation:  1 
   Custom sensor type:  customSIMstop1 
   Custom sensor parameters:  
    expr : (u[1] > u[2]) 
    min_time : 30 
    threshold : 0.2 
    OpenFcnBlock : CustomMSMOpenFcn 
 
   Actuators: 
 
  1. Actuator name:  Engine_speed_sensed  
   Block path:  idle_speed_cntrl/Controller 
   Groups:  All 
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   Activate:  1 
   Enable:  1 
   User comments:  
   Inport No.:  1 
   Math function:  u(1) + u(2) 
   Sample time:  -1 
   Source type:  Constant 
   Source properties:  
    Value : 50 
    VectorParams1D : on  
   Calibrations: 
 
    1. Calibration name:  Cntrl_pgain  
   Blockpath:  idle_speed_cntrl/Controller/discrete_control_algorithm/Gain1 
   Groups:  All, controller 
   Activate:  0 
   Enable:  1 
   User comments:  
   Block type:  Gain 
   Parameter:  Gain 
   Startup value:  0.003 
   Previous value:  0.003 
   Current value:  0.003 
   Snapshot value:  0.003 
   Stored value:  0.003 
 
 
   Groups List: 
  All, engine_speed, controller 
 
   Current Group: All 
 
   Instrumentation option: Instrument all groups 
 
   Experiment comments: 
  the simulation stops when the idle_speed falls within given tolerance 
 
________________________________________________________________________ 
Model Test Manager - Version 1.0 

6.26 Exiting Model Test Manager 
The MTM tool can be exited by using the pull down menu under File and selecting Exit 
(see Figure 22). The user is prompted for saving instrumentation data before exit. 
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7 File Search Engine 
Model Test Manager includes a Search Engine for files. The File Search Engine GUI (see 
Figure 23) can be invoked using Tools > File Search Engine (see Figure 15). This GUI 
has the following fields: 

 
Figure 23: MTM - File Search Engine GUI 

1. Search Filter: It is a pull down menu using which you can filter on the file type 
to search. 

2. Search String: You can enter one or more keywords to search for. Press “ Enter”  
after typing in the string(s) to initiate the search. You can use “ *”  as the wildcard 
search string to display all the tracked information. 

3. Search Results: Displays results from the search operation. 
4. Comments: Displays the comments (that had been entered while saving the data) 

associated with the element selected under Search Results. 
5. Model: Displays the Model Name (if one was saved initially) associated with the 

data. 
6. Date: Displays the time stamp when the save operation was performed. 
7. Load: A button to load the selected file under Search Results into. If the selected 

file is an mns file, then it is loaded into MTM. If the selected file is a mat file, it is 
loaded into base-workspace. 

8. Close: A button to close the File Search Engine GUI. 
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Types of files that can be searched 
Currently, the instrumentation files (with *.mns extension) and binary data files (with 
*.mat extension) can be searched using this Search Engine. The binary data files have to 
be saved using the Data Save tool within MTM and the instrumentation files have to be 
saved using the Save Instrumentation menu option within MTM. The search results are 
filtered based on the keywords that are entered as Search Strings in the File Search 
Engine GUI. 
Searching for keywords in files 
You can enter user comments while saving instrumentation data or data (using Data Save 
tool). This information is independently kept track of in a simple “ database” . These saved 
comments are searched for the keywords when the File Search Engine is used. You can 
use “ *”  as the wildcard search string to display all the tracked information. 
Viewing the file search results 
All the files that have any of the searched strings in their user comments are displayed in 
the Search Results window. The full path of the file is displayed as the tool tip string. 
Select the item in the Search Results window and keep the mouse on the item to display 
the path where the file has been saved. The user comments associated with any selection 
in the Search Results window is displayed in the User Comments window.  
Loading the data corresponding to a particular search result 
The data corresponding to a selected search result can be loaded into  (if it is a *.mat file) 
or into the main MTM GUI (if it is a *.mns file). Click on the Load button to load the 
data. If the tracked file is no longer at the saved destination folder, then the tool shows an 
error message. This could happen if the target file was moved by the user after saving it 
using the Data Save tool. So, the tracked information no longer matches with the actual 
location of the file. 
Exiting the file search engine 
The File Search Engine is exited by clicking on the Close button in the GUI. 
8 Data Save Tool 
The Model Test Manager contains another set of tools to aid saving of simulation run 
outputs. Usually, saving of simulation outputs (in standard Simulink package) captured 
as ToWorkspace elements requires careful sifting through the workspace and running a 
save command to selectively save those outputs in a data file. This task is tedious. The 
advantage of the MTM Data Save tool is that all of the ToWorkspace elements 
instrumented with the MTM tool can be saved with a single mouse click. The user can 
also edit this save list and selectively include other workspace data (such as model 
parameters) in the saved file. The user is prompted for entering comments in the save 
process. These comments can be used later on to search through the data files in the File 
Search Engine. 
 
Two Data Save Tools are available in Model Test Manager (see Figure 24). 

8.1 Saving all the ToWorkspace instrument variables 
The user can save all the ToWorkspace variables from the corresponding elements 
instrumented with the MTM tool. You have to use the pull down menu under Tools in the 
main MTM GUI and select Save Data > Save All ToWorkspace (see Figure 24). The user 
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is asked to supply a file name and optionally some comments. The tool queries the 
Instrument List and saves all the ToWorkspace variables in the target file. This includes 
those Scope instrument variables that have been piped to the workspace and those of 
actuators. The Model Name in the MTM GUI is also saved automatically for information 
tracking purposes. 

 
Figure 24: Data Save Tool Selection from Main MTM GUI 

8.2 Saving a selective set of data 
The user can selectively edit the ToWorkspace variables that need to be saved and then 
add some variables from the workspace before saving to a file. The data from workspace 
may include model parameter values that were used in the simulation of the system. This 
may be a means to save the complete experimental setup (parameter values, input values 
and state initial conditions) along with the simulation outputs (captured in ToWorkspace 
blocks) in one data file. The user is asked to supply a file name and optionally some 
comments. This save option can be accessed by using the pull down menu under Tools in 
the main MTM GUI and selecting Save Data > Edit Save List (see Figure 24). This 
operation invokes the MTM – Save Instrument Data GUI (see Figure 25). This GUI 
contains the following fields: 

1. Model Name: Displays the Model Name from the main MTM GUI. This can be 
changed by the user. This name is saved with the data for information tracking 
purposes. 

2. Instrument List: This displays all the ToWorkspace MTM instrument variables 
in the active model in the main MTM GUI. This includes those Scope instrument 
variables that have been piped to the workspace and those of actuators. 

3. Save List: This displays all the variables that will be saved to the data file. 
4. Add: Recently selected item in the ToWorkspace Signals or Workspace List get 

added to the Save List by clicking on this button. 
5. Remove: The selected item in the Save List can be removed by clicking this 

button. 
6. Add All: All the elements of recently selected list (ToWorkspace Signals or 

Workspace List) get added to the Save List by clicking this button. 
7. Remove All: All the entries in the Save List can be removed by clicking this 

button. 
8. Cancel: The GUI can be closed without saving by clicking on this button. 
9. Save: The variables in the Save List dialog are saved and the GUI is closed by 

clicking on this button. 
10. Workspace List: This displays all the MATLAB® workspace variables. Select 

the workspace variable that is to be included in the Save List, and then click Add. 
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This operation adds the selected workspace variable to the Save List in the 
Instrument Signal Save GUI. 

 
Figure 25: MTM - Save Instrumentation Data GUI 

9 Batch mode usage of MTM 
The Model Test Manager can be used in a batch mode script to apply pre-saved 
instrumentation setup information on a model. The main MTM GUI is not used for the 
batch mode. Using the main MTM GUI, you will create (probably several) 
instrumentation configurations for the same model. You may want to apply these 
instrumentation configurations in a certain sequence for subsequent simulation runs of 
the model. The simulation runs can be programmed using m-scripts to be used in a batch 
mode. The batch mode script of MTM can be used in the same m-scripts to add pre-saved 
instrumentation setups to the model. The command syntax is as follows: 
 
>> instrument_model(<modelname>,<datafilename>,'batchmode')  
 
Here, modelname refers to the model that would be active and where the instruments 
need to be placed, datafilename refers to the data file with a *.mns extension where the 
desired instrumentation information was saved during an interactive session and 
‘batchmode’  is the keyword that tells the program to work as a batch mode script. A 
representative section of such a batchmode script may look as follows: 
 
% start 



Model Test Manager User’ s Guide 
Copyright © 2000 – 2004 Emmeskay, Inc. 

Page 40 of 45 

% assume model already open and the desired simulation parameters set. 
% 
instrument_model(‘idle_speed_cntrl’, ‘base_idle.mns’, ‘batchmode’); 
sim(‘idle_speed_cntrl’); %simulate the model 
save base_data %save all the simulation results in base_data.mat 
instrument_model(‘idle_speed_cntrl’, ‘dashpot_idle.mns’, ‘batchmode’); 
sim(‘idle_speed_cntrl’); % simulate the model 
save dashpot_data % save all the simulation results in dashpot_data.mat 
% 
% end 
 
To remove all instruments from a model, 
>> instrument_model(<modelname>,'remove','batchmode') 
 
Important: If the “ Instrument Current Group Only”  feature is ON while saving the mns 
file then the instruments & calibrations belonging to the current group (is the group 
which is selected while saving the mns file) only will be instrumented in the batch mode. 
 
Caution: An mns file shall not be saved as 'remove.mns'. 
 
10 MATLAB Command Line usage of MTM 
The MTM tool can be invoked from the command line in several ways. This tool 
information can also be seen by typing help instrument_model in the command line. 
Invoking the main MTM GUI: The main GUI can be opened by typing 
instrument_model on the command line: 
 
>> instrument_model 

 
If this is the first time you are starting the tool, then you can also view and accept the 
license agreement to continue usage. Once the tool GUI is open, you can start browsing 
an open model by typing its name (and pressing “ Enter” ) in the Model Name field. 
 
Invoking the main MTM GUI and loading a model in the System Tree: The main 
GUI is opened and the desired model is loaded into System Tree for browsing using the 
command: 
 
>> instrument_model(<modelname>) 

 
where modelname is the name of the Simulink model that needs to be browsed. If the 
model is not already open, then the tool opens the model and pulls in the architecture tree 
into the System Tree window of the main MTM GUI. 
Example: instrument_model(‘vehicle’ ) opens the MTM GUI and loads the model 
vehicle.mdl in the system tree. This assumes that vehicle.mdl is in the MATLAB path. 
 
Invoking the main MTM GUI, loading a model in the System Tree and loading an 
associated instrumentation file in the GUI: This can be done by using the command: 
 
>> instrument_model(<modelname>,<datafilename>) 



Model Test Manager User’ s Guide 
Copyright © 2000 – 2004 Emmeskay, Inc. 

Page 41 of 45 

 
Here, modelname is the name of the desired Simulink model and datafilename is the 
name of the file where the instrumentation information is stored. This should open the 
model, pull up the model in the System Tree in the main MTM GUI and load the 
instrumentation information in the Instrument List window. 
Example: instrument_model(‘vehicle’ , ‘vehcfg.mns’ ) opens the MTM GUI and loads the 
model vehicle.mdl in the System Tree. It also loads the instrumentation setup previously 
saved as vehcfg.mns. The model loaded with this command could be any of the sister 
models of vehicle.mdl which only differ in the name from vehicle.mdl. This assumes that 
vehicle.mdl and vehcfg.mns are in the MATLAB path. 
 
Running the MTM Tool in a batch mode: This process is described in detail a separate 
section. This mode can be run using the command: 
 
>> instrument_model(<modelname>,<datafilename>,'batchmode') 
 

Example: instrument_model(‘vehicle’ , ‘vehcfg.mns’ , ‘batchmode’ ). This command is 
used to impose the configuration in “ vehcfg.mns”  on the model “ vehicle”  in a 
batchmode. The model loaded with this command could be any of the sister models of 
vehicle.mdl which only differ in the name from vehicle.mdl. This assumes that 
vehicle.mdl and vehcfg.mns are in the MATLAB path. 
 
11 Working with library-linked elements 
The use of library-linked model elements provides a means of reusing building blocks 
within a model. As an example, you may have several models for internal combustion 
engines. Each of these models may have an element for the intake manifold dynamics. 
The equations that describe the intake manifold dynamics may be the same across all of 
the models. Instead of maintaining several copies of the intake manifold dynamics model 
(in each of the engine models), you may choose to create a library for the intake manifold 
dynamics component and then import a copy of this model in each of your engine 
models. The main advantage of this approach is that you have to maintain the model at 
one location inside a library and all the destinations of that element are automatically 
updated.   
 
In the standard Simulink package, the debug process on a model with several library-
linked elements gets very tedious. This is because you cannot directly add sensors in the 
library-linked model elements. You have to make the changes in the source element 
(inside a library) and then run the simulation. After the debugging is complete, you have 
to remember to delete all the sensors in the libraries because those may be shared across 
several models. Also, Simulink does not allow users to add Scopes inside library 
elements. As veteran Simulink users know, Scopes are a popular means to debug and 
test a model before releasing it for general use. So, this shrinks the debugging arsenal of a 
model developer who uses library-based structures. 
 
Model Test Manager makes it easy to add instruments inside library-linked elements. As 
far as the user of MTM tool is concerned, there is no difference in the instrumentation 
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process between library-linked and non-linked elements in the model. The user browses 
through the System Tree and places instruments on the desired signals. The tool takes 
care of the rest of the processing. Viewing an instrument placed inside a library-linked 
element is similar to viewing an instrument placed directly in the model. 
 
Using MTM, you can place Scope blocks inside library-linked elements of a model. In 
order to utilize this new functionality, you have to enter the Scope Input Width for 
library-linked elements (see Properties of an instrument). This field is ignored for Scope 
instruments that are placed in non-linked model elements. Here, Scope Input Width refers 
to the number of scalar signals that are on the signal line that is being instrumented. As an 
example, if you want to instrument a Scope on a vector signal of width 7 inside a library-
linked element, then you would enter 7 in the Scope Input Width field. Also, the Scopes 
on library-linked elements display the signal as piece-wise constant values. The values 
between the sample points are held constant on these Scope displays. 
 
Another powerful feature in MTM is the ability to instrument individual signals in 
library-linked elements that have multiple instantiations in a model. As an example, take 
the case of an IC engine model that has valve equations modeled as a library-linked 
element. Furthermore, assume that the IC engine uses the same valve equation library 
link in three places in the model. Let us also assume that the user wants to capture mass 
flow signal in these library-linked equations in only two places in the IC engine model 
(the third instantiation need not be instrumented). Currently, this data cannot be captured 
using a ToWorkspace or a Scope block in Simulink. However, using MTM, the user can 
tap into any signal inside any of the multiple instantiated library-linked elements and 
capture that signal in one, any or all of the instantiated locations. The only restriction is 
that the same instrument type (ToWorkspace, Scope or Display) be used at all the 
instantiated locations where a particular signal needs to be captured. 
 
12 Some restrictions on names used in Simulink 
No slash symbols (“ /” ) are allowed in the model, block or signal names. The slash 
symbols are used to differentiate different levels in a model. Although we have taken 
special care in the tool implementation so that “ /”  symbols do not lead to errors, there is 
no guarantee that the tool will not error out in some unique situations where special 
characters are used in block and signal names. As a safe option, it is advised to use 
standard alphanumeric characters in the system, block and signal names. Underscore 
(“ _” ) symbols can be used to separate words in the names. Special characters such as 
tabs, $, ^, &, #, *, carriage return and white spaces are to be avoided. 
 
13 Some Frequently Asked Questions 

13.1 When I instrument a model, how do I know which of the signals have not been 
instrumented due to their unavailability (due to changes in the model)? 

When the Instrument Model command is processed, all the available signals are 
instrumented. The unavailable signals are marked with an “ X”  in front of their names in 
the Instrument List window in the main MTM GUI (see Figure 2). This feature is not 
available in the batch mode. 
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13.2 Does saving a model or library save the instruments along with it as hard-coded 
elements? 

No, this is the unique and powerful feature of the Model Test Manager. Instrumentation 
data is kept track of as a separate entity. The models are left uncorrupted. 

13.3 Can I use the instrumentation configuration on a related model that differs 
only in its name from the original model? 

Yes, the instrumentation will work as long as the blocks within the models are the same. 
The unavailable signals (that were available in the original model) are displayed with the 
“ X”  symbol in front of the respective instrument names in the Instrument List. You can 
use the batch mode command to do this or use the interactive mode as follows. Open the 
instrumentation information file using the pull down menu under File in the main MTM 
GUI. Type in the desired model name in the Model Name field and press “ Enter” . When 
the tool asks if the instrument list can be retained, pick “ Keep”  option. Click on the 
“ Instrument Model”  button to complete instrumentation of the new model.  

13.4 When I save, close and re-open a model, all the instruments within a library-
linked element are present. I thought that the save operation should not save the 
instruments as hard-coded elements. What is going on? 

The save operation will not save the instruments in the model as hard-coded elements. 
When you open a model all the associated libraries are opened in the memory by 
Simulink although you don’ t see them in the screen. Closing the model does not close 
the associated libraries automatically. When you instrument a signal inside a library-
linked element, the instrument is placed inside the library (although the library is not 
visible on the screen). When you close and re-open a model, it automatically pulls in the 
library elements from the open libraries. Hence, you will see the instruments inside the 
library-linked elements when you close and re-open the root model. To close all the open 
models and libraries use 

>> bdclose all 
at the MATLAB command prompt. If you want to delete the instruments inside a 
library, browse this library by entering its name in the Model Name window of the main 
MTM GUI and pressing “ Enter” . Select Remove Instruments from Model under the 
menu Tools to remove all instruments.  

13.5 Can I instrument a signal that is inside a library-linked element and this 
library-linked element is used in multiple places within the same model? 

Yes, you can instrument such signals. However, the only restriction is that if multiple 
instantiations of the same signal need to be instrumented in a model, then the same 
Instrument Type (ToWorkspace, Scope or Display) need to be used at all the locations. 

13.6 I have used the “ Remove instruments from model”  command from the Tools 
menu bar, but sometimes the instruments in the open window on the screen 
does not get deleted. Is this an error in the tool? 

Sometimes Simulink does not seem to update the open system page especially in the 
model browser mode. The changes have taken place and the instrument should have been 
deleted with the pull down menu command. The best way to check this is to go to another 
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page in the model through the model browser and then come back to the same old page. 
You should not see the instruments in this case. 

13.7  What is the difference between the view in the System Tree window of the 
main MTM GUI and the Simulink Model Browser? 

The System Tree displays all the blocks with outputs while the Simulink Model 
Browser displays only the subsystems. There is no means to look at the signals in the 
Simulink Model Browser while the outputs of the selected block are displayed in the 
Outputs window of the main MTM GUI. 
 

13.8 Can mns files of MIM be used in MTM?  
Yes. Experiment setup files (mns files) of MIM can be seamlessly loaded into MTM. 
After using previous mns file, the experiment setup can be saved in previous version. 
Saving in previous version does not save actuators, calibrations and groups information. 
 

13.9 I am not able to edit or change the groups property using the “ Edit Instrument 
Property”  GUI. 
Groups can be added to (or removed from) an instrument only by using the context menu 
of that instrument list. In the edit properties GUI, you can only view the groups to which 
the instrument belongs. 

13.10 From the main MTM GUI, how do I know which of the instruments or 
calibrations are not activated or not enabled? 
In the main MTM GUI all the instruments or calibrations, which are not enabled or not 
activated, are marked with an “ x”  in the front of their names in the 
Sensor/Actuator/Calibration List.   

13.11 I am not able to access or select context menu options in the Calibration List 
in the main MTM GUI. 
Launching online calibration disables the context menu options in the calibration list and 
closing the online calibration GUI enables the context menu options. Hence make sure 
that the online calibration is closed when accessing or selecting the context menu options 
in the Calibration List in the main MTM GUI.  

13.12 It is taking too much time while resizing the main MTM GUI. 
While doing resizing, after dragging the MTM window bring the cursor (mouse pointer) 
into the MTM window for resize to complete. If the cursor is outside the MTM window 
resize will not be completed. 

 
 
MATLAB, Simulink and Stateflow are Registered Trademarks of The MathWorks, 
Inc., 24 Prime Park Way, Natick, MA 01760-1500. Visit www.mathworks.com for 
details. 

http://www.mathworks.com/


Model Test Manager User’ s Guide 
Copyright © 2000 – 2004 Emmeskay, Inc. 

Page 45 of 45 

 


	1 Getting Started
	1.1 What is the Model Test Manager?
	1.2 When do you use the Model Test Manager?
	1.3 How can you use the Model Test Manager?
	2 System Requirements
	3 Installation Instructions
	4 Quick Tutorial
	5 Before you begin
	5.1 Including the MTM folders in MATLAB( path
	5.2 Enabling a model for MTM usage
	5.3 Signal Capture Block Parameter Options
	5.4 Invoking MTM from MATLAB LaunchPad
	6 The main Model Test Manager GUI
	6.1 Adding a signal to the Sensor/Actuator/Calibration Lists
	6.2 Delete signals from the Sensor/Actuator/Calibration Lists
	6.3 Add instruments and calibrations to a model
	6.4 Remove instruments and calibrations from the model
	6.5 Properties of Sensor, Actuator & Calibration
	6.5.1 Properties of Sensors
	6.5.2 Properties of Actuators
	6.5.3 Properties of Calibrations
	6.6 Viewing properties of an instrument or a calibration
	6.7 Modifying properties of an instrument or a calibration
	6.8 Activating / deactivating an instrument or a calibration
	6.9 Enabling / disabling an instrument
	6.10 Groups
	6.11 Sorting the names in the Sensor/Actuator/Calibration List
	6.12 Opening an instrument to view simulation results
	6.12.1 Selecting a single instrument and right-clicking on the selection
	6.12.2 Selecting multiple instruments and right clicking on the selection
	6.13 Plot slider
	6.14 Saving and Loading plot settings (Save Plot-Set, Load Plot-Set)
	6.15 Applying New Values of Calibrations
	6.16 Taking and Applying Snapshots of Calibrations
	6.17 Calibrating model parameters while Simulation is running
	6.18 Identifying the parent block of a MTM instrument signal
	6.19 Capturing the User Preference for open instruments
	6.20 Save format for instrumentation setup information
	6.21 Saving instrumentation setup information
	6.22 Saving instrumentation information as a new file
	6.23 Attaching user comments to the saved information
	6.24 Opening a saved instrumentation setup file
	6.25 Printing instrumentation information
	6.26 Exiting Model Test Manager
	7 File Search Engine
	8 Data Save Tool
	8.1 Saving all the ToWorkspace instrument variables
	8.2 Saving a selective set of data
	9 Batch mode usage of MTM
	10 MATLAB( Command Line usage of MTM
	11 Working with library-linked elements
	12 Some restrictions on names used in Simulink(
	13 Some Frequently Asked Questions
	13.1 When I instrument a model, how do I know which of the signals have not been instrumented due to their unavailability (due to changes in the model)?
	13.2 Does saving a model or library save the instruments along with it as hard-coded elements?
	13.3 Can I use the instrumentation configuration on a related model that differs only in its name from the original model?
	13.4 When I save, close and re-open a model, all the instruments within a library-linked element are present. I thought that the save operation should not save the instruments as hard-coded elements. What is going on?
	13.5 Can I instrument a signal that is inside a library-linked element and this library-linked element is used in multiple places within the same model?
	13.6 I have used the Remove instruments from model command from the Tools menu bar, but sometimes the instruments in the open window on the screen does not get deleted. Is this an error in the tool?
	13.7 What is the difference between the view in the System Tree window of the main MTM GUI and the Simulink( Model Browser?
	13.8 Can mns files of MIM be used in MTM?
	13.9 I am not able to edit or change the groups property using the Edit Instrument Property GUI.
	13.10 From the main MTM GUI, how do I know which of the instruments or calibrations are not activated or not enabled?
	13.11 I am not able to access or select context menu options in the Calibration List in the main MTM GUI.
	13.12 It is taking too much time while resizing the main MTM GUI.
	system requirements
	installation instructions
	main MTM GUI
	simulink lib screen shot
	include in path
	enable mim mdl
	model w sigcapture
	remove signal instr
	remove model instr
	instrument props
	scope in lib
	modify instr prop
	batch mode
	matlab cmd mim
	mathworks trademark

